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1 ABOUT THIS MANUAL 

This manual describes how to configure TONN8 using IQVISION software and comprises the following main 

sections: 

About TONN8 

This section gives an introduction to the basic system principles and the  TONN8 hardware. 

Securing TONN8 

This section provides guidance on security issues to be considered when installing and using TONN8. 

Engineering Procedure 

The following sections describe the process of setting up and configuring TONN8. 

Install TONN8 

License TONN8 

Connect to the IQVISION PC 

Open a Platform 

Run the Commissioning Wizard 

Set up a Station 

Open the Station 

Configure TCP/IP Settings 

Connect to the Trend IQ System (not IQX) 

Connect to Third Party Systems 

Link Values Between Trend and 3rd Party Systems 

Configure TONN8 to receive alarms 

Backup the Configuration 

Appendices 

Various additional procedures and information that may occasionally be required when setting up TONN8, 

including communicating with TOPS, resetting to factory defaults, and synchronising the time with IQ 

controllers. 

TONN8 is based on the powerful Niagara 4 (v4.9) software framework and uses the Trend N4 Driver. It is assumed 

that you have an understanding of Niagara 4. For further information, please refer to Product Training and Niagara 

Help. 

1.1 Product Training 

It is assumed that you have attended the Trend TONN8 training course. For details of this and other training courses 

provided by Trend, please visit: https://www.trendcontrols.com. 

1.2 Related Documentation 

The following documents are referenced in this manual and may be required for additional information when installing 

and configuring TONN8: 

▪ TONN-8 Trend Open Network Node Data Sheet (TA201413) 

▪ General Security Best Practice for Trend IP Based Products Information Sheet (TP201331) 

▪ Niagara 4 Hardening Guide 

▪ TONN8 Manual (TE201415) 

▪ IQVISION Configuration Manual (TE201382) 

▪ IQV-NA-x, TONN-NA-x Analytics Data Sheet (TA201430) 

▪ ESIG E-Signature Data Sheet (TA201432) 

All of these documents can be downloaded from the Trend e-library on the PNet support web site 

(https://partners.trendcontrols.com). 

Some of the above documents, together with additional Niagara documents, can be found in the 'lib' folder of the 

TONN8 installation. By default, this is located in the \lib folder. 

https://www.trendcontrols.com/
https://partners.trendcontrols.com/
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1.3 Niagara Help 

IQVISION includes an extensive library of Niagara documentation as part of its installation. 

To access the Niagara Help System: 

1. Click Help on the menu bar. 

2. Select Help Contents. The Niagara Help window is displayed: 

 

3. In the Help side bar locate the required document, click the > icon to view its list of contents, and double-

click on a topic to open it. 

Note: If the Help side bar is not visible, click the Side Bars menu and select Help. 

1.4 Conventions Used in this Manual 

There are numerous items and instructions in this manual, the conventions below are designed to make it quick and 

easy to find and understand the information. 

▪ Menu commands are in bold type. 

▪ Buttons, and options in dialogue box that you need to select are in bold type. 

▪ The names of text boxes and dialogue boxes are in bold type. 

▪ Key combinations that you should press appear in normal type. If joined with a plus sign (+), press and hold 

the first key while you press the remaining one(s). For example CTRL+S indicates holding down the control 

key while pressing S. 

▪ Text you should enter is in Italic type. 
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1.5 Contacting Trend 

Head Office 

Trend Control Systems Limited 

St. Mark's Court 

North Street 

Horsham 

West Sussex  

RH12 1BW 

Tel: +44 (0) 1403 211888 

Fax: +44 (0) 1403 241608 

Details of regional offices can be found on our web site. 

Internet 

Our company web site (www.trendcontrols.com) provides information about our products and us. Accredited partners 

should contact our PNet support web site (https://partners.trendcontrols.com). 

Technical Support 

Our support department provides technical support during normal office hours. Before contacting our support 

department ensure that you have your Technical Support PIN number available, without this we will be unable to 

provide you with any support. 

Tel: +44 (0) 1403 226600 

Email: trendts@trendcontrols.com 

Fax: +44 (0) 1403 226310 

Note: Trend Technical Support are only able to provide support for TONN8 and the Trend driver features described 

in this manual. They are unable to provide support for 3rd party drivers and undocumented aspects of TONN8's 

operation. 

Technical Publications 

Please send any comments on this or any other Trend technical publication to techpubs@trendcontrols.com. 

 

  

http://www.trendcontrols.com/
https://partners.trendcontrols.com/
mailto:trendts@trendcontrols.com
mailto:techpubs@trendcontrols.com
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2 ABOUT TONN8 

The Trend Open Network Node (TONN8) is a Trend network device that enables the Trend system to interface with 

3rd party systems such as BACnet, LONWORKS®, Mbus, MODBUS, SNMP, and KNX. It utilises the Niagara 4 

Framework for the integration of Heating, Ventilation, Air Conditioning (HVAC) systems and non-HVAC systems 

(e.g. lighting) in a building. 

 

2.1 Hardware 

The TONN8 hardware is housed in a small plastic enclosure capable of being mounted either on a wall or standard 

DIN rail. 

The TONN8 has two onboard Ethernet ports and two RS-485 ports used for connection to the systems that it is to 

integrate. If required additional communications ports for RS-485, RS-232 or LON can be added by installing up to 4 

expansion modules. 

2.1.1 Installation 

For full details on the physical installation of the TONN8 hardware see the TONN8 Installation Instructions - 

Mounting (TG201414). 

For full details on the physical installation of expansion modules see the HON-NXEM-xxx Expansion Modules 

Mounting Instructions (MU1Z-1031GE51). 

2.1.2 Connection 

TONN8 connects to the Trend network over Ethernet using a virtual CNC (vCNC) in another Trend device. 

Connection to 3rd party systems is via any of its onboard communications ports (Ethernet or RS-485) or those provided 

by any installed expansion modules (RS-485, RS-232 or LON). 

TONN8 is supplied with the Trend N4 Driver enabling it to interface with the Trend system over Ethernet - see Trend 

N4 Driver. Several 3rd party drivers are provided as standard allowing the unit to interface with a wide range of 3rd 

party systems - see 3rd Party Drivers. 

 



About TONN8 

10 TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 

2.2 Configuration 

TONN8 is configured using the IQVISION. For further details on how to install and licence IQVISION, please refer 

to the IQVISION Configuration Manual (TE201382). 

This manual describes how to configure TONN8 using IQVISION. 

If changes are required to an existingTONN8's configuration you must use the same version of IQVISION to make 

them. If a later version of IQVISION is to be used, ensure that the TONN8's licence will allow it. 

If you are using IQVISIONv2.20 or greater and the TONN8 that is to be modified was configured using an earlier 

version of IQVISION(v2.10) the TONN8's station will need to be converted. A special conversion process must be 

followed - see the PNet support web site (https://partners.trendcontrols.com). 

2.3 System Integration 

TONN8 can be configured in various ways to provide integration between the Trend system and 3rd party systems. 

Read/Write Values 
TONN8 enables values from the Trend system to be read and written by the 3rd party systems., and for the Trend 

system to read values from and write values to the 3rd party systems. 

 

Access Logged Data 
Data logged by Trend controllers can be accessed by a 3rd party supervisor via the TONN8. The TONN8 must be 

configured to archive the required logged data from the Trend controller(s) and make it available as a Niagara history. 

The 3rd party supervisor then requests the logged data from the TONN8. The data is then passed from the TONN8 to 

the supervisor where it can be processed as required, e.g. to display a graph of the data. 

 

Receive Alarms from the Trend System 
Alarms from the Trend system can be received and acknowledged from a 3rd party supervisor through the TONN8's 

Niagara framework. 

The controller must be configured to either send the alarms to the vCNC that the TONN8 is connected or to the 

TONN8's IP address and port number it listens for alarms on. The TONN8 must have its alarm service configured 

with a console recipient. This places the alarms in the TONN8's Niagara framework. The TONN8 and supervisor must 

then be configured accordingly. 

Adjust Time Schedules in the Trend System 
Time Schedules in Trend controller in the Trend System can be adjusted by a 3rd party supervisor through the 

TONN8's Niagara framework. In order to do this Niagara schedules in the TONN8 must be linked to Time Schedule 

modules in the Trend controller. When the supervisor adjusts the Niagara schedule the changes are sent to the linked 

Time Schedule module in the Trend controller. 

https://partners.trendcontrols.com/
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2.4 TONN8 Architecture 

TONN8 is based on the powerful Niagara 4 software framework. The following sections provide a basic introduction 

to the key elements and terminology used in this framework, and how it functions within TONN8. 

Niagara Framework 

Trend N4 Driver 

3rd Party Drivers 

Platform 

Station 

2.4.1 Niagara Framework 

The Niagara Framework uses different drivers to communicate with different network protocols. Data read from a 

network is translated or 'normalised' via the driver into Niagara protocol. Normalised data can then be translated back 

into another protocol, enabling data to be easily exchanged between networks. 

Using the integral Trend N4 Driver, TONN8 can communicate with one or more Trend IQ systems. Additional third 

party drivers are also available, enabling IP-based communication with a wide range of other network types including 

BACnet. For serial-based networks one or more TONN8 can be used to provide RS-485, RS-232 and LonWorks 

connectivity. TONN8 communicates via the Niagara Network Driver. The Niagara Driver is also used to communicate 

with Trend IQX systems. 

 

2.4.2 Trend Systems 

2.4.2.1 Trend IQ System 

TONN8 supports current and legacy sites built using IQ4, IQ3, IQ2, IQL and IQeco controllers, using IQ firmware 

and configured using IQSET. 

2.4.2.2 Trend IQX System 

Trend IQX is a fully Niagara-based system and designed for high specification integrated building environments, 

focusing on occupant well being or access to rich building performance data. It uses different drivers to provide 

network communications in much the same way as IQVISION. A range of standard drivers are included with IQX 

and these are licensed based on a point count. For further details on the IQX functionality, standard drivers and point 

licensing, refer to the IQX Data Sheet (TA201449). 

A separate license is required to add IQX connectivity to IQVISION - this uses the same licensing mechanism as 

TONN8 devices, with the license based on the number of IQX controllers required, regardless of the number of points 

licensed in the controller. For further details refer to the IQVISION Data Sheet (TA201381). 

IQX controllers are configured using IQVISION and communicate with IQVISION via the Niagara driver. For full 

details please refer to the IQX Configuration Manual (TE201448). 
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2.4.3 Trend N4 Driver 

The Trend N4 driver is used exclusively for Trend IQ systems. It defines the communication settings to the system 

and provides access to data held in its controllers and devices, including: 

▪ Points - for reading/writing input values from Sensor, Knob, Switch and Digital Input modules, and output 

values for Driver modules. TONN8 also supports read/write access to any other strategy module parameter 

that is accessible via text comms. 

▪ Schedules - for viewing and adjusting occupancy or operation times (Time Schedule modules). 

▪ Histories - for displaying data/graphs from values logged in Plot modules. 

▪ Alarms - for monitoring and acknowledging alarm messages generated within the Trend system. 

The driver can manage connections to multiple Trend sites. 

2.4.3.1 Site Connections 

The Trend N4 driver connects to a Trend network over Ethernet using a vCNC in a Trend device. Initially, a single 

vCNC is specified (the 'Initial Connection Endpoint'). This gives TONN8 access to the Trend devices on the associated 

(local) Trend LAN and, where a vINC (or INC) type node is also present, access to other LANs and devices on the 

wider internetwork: 

 

Subsequently, TONN8 discovers all available vCNCs on the site. It is then recommended that TONN8 is configured 

to have multiple connections to each site. This is for two reasons: 

▪ to provide continuity of communications in the event that a particular vCNC is not available (e.g. the associated 

device is offline). 

▪ to allow faster data transfer is (e.g. when downloading plot data/histories) by spreading the load across multiple 

connections simultaneously. 

Note: With older Trend systems that have a current loop internetwork, providing additional VCNC connections for 

IQVISION may actually reduce performance. 

For optimum performance it is suggested that each LAN has its own Primary connection and (if possible) one 

Secondary connection: 

▪ the Primary connection is used by TONN8 as the default for all communications on the LAN. 

▪ the Secondary connection will only be used if the Primary connection is not available (e.g. the associated 

device is offline). 
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The Primary and Secondary connections must, therefore, be on different devices. If they were on the same device and 

the associated device went offline, both connections would be lost. 

TONN8 allows vCNC connections to be either Permanent or On Demand: 

▪ a Permanent connection enables two-way communication between TONN8 and the vCNC host device at any 

time. This is recommended in most cases and is essential for the monitoring of alarms via a vCNC connection. 

▪ an On Demand connection is temporary and only made when TONN8 initiates read/write communications 

with the site. Once communication is complete, the connection is closed. This is not suitable for alarm 

monitoring but can be used for periodic collection of plot data. 

Note: On Demand connections are typically only used when accessing remote devices using dial-up networking. 

2.4.4 3rd Party Drivers 

The Niagara framework supports a wide range of additional drivers, suitable for interfacing with other manufacturer's 

building automation systems and products. This enables the monitoring and control of these systems to be fully 

integrated with the management of a Trend system. 

TONN8 is provided with several 3rd party drivers as standard - see the TONN8 Data Sheet (TA201413) for a list of 

both supplied and optional drivers. 

2.4.5 Platform 

The Platform is the topmost level of configuration and may be compared to the control panel on a PC. It comprises a 

number of tools and configuration pages where you can: 

▪ Set up communications, including configuring SSL 

▪ Install licenses 

▪ Select different languages 

▪ Fault find issues via the Application Director 

▪ Copy, rename and delete Stations using the Station Copier 

Access to the Platform settings requires the user to login by username and password. 

Note: The Platform is not accessible via the TONN8 web interface. 

2.4.6 Station 

The station is the core of TONN8 and manages communications with the Trend system(s) and third party systems, 

and acts as a 'container' for all other configuration settings and functions. These include: 

▪ Services - such as alarm listening/monitoring 

▪ Drivers - for managing access to data in the Trend system(s) and other systems. 

▪ Files - schematic/PX Pages used to present system information on remote client devices. 

Access to the station settings requires the user to login. Initial system configuration is achieved using a default 

admin/engineering user account which is set up when the station is created. Once configuration is complete further 

user accounts can be added that grant different users specific access rights according their role. 
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3 SECURING TONN8 

The purpose of this section is to provide the information necessary for those involved in the installation and 

maintenance of a product or system to understand the requirements for configuring and managing the security of the 

product or system. 

Additional information may be obtained from: 

▪ General Security Best Practice for Trend IP Based Products Information Sheet (TP201331) 

▪ Niagara 4 Hardening Guide. 

Both documents are available from the Trend PNet web site (https://partners.trendcontrols.com). 

3.1 TONN8 Security Check List 

Latest version of TONN8 operating system is being used. 

 TONN8 installation files, configuration files (including station backup), certificates and licences are included 

in disaster recovery plan. 

 The TONN8 should, where possible, be secured against unauthorised physical access. 

 The Ethernet network (and any other networks) that the TONN8 is connected to is secured, e.g. using 

firewalls and intrusion detection systems. 

 All PCs connecting to TONN8 are running the latest version of the Windows operating system,with all 

updates and service packs. 

 All PCs connecting to TONN8 are running virus protection software. 

 Appropriate user accounts are set up on the TONN8 (and all associated PCs) and that access to files is 

restricted to only those who are authorised. 

 TONN8 is configured to use HTTPS using a certificate from a trusted Certificate Authority. 

 TONN8 users are configured as required. 

 Ensure TONN8 is configured to backup data regularly to a secure location as per your company's backup 

policy. 

In addition to the actions described in the 'General Security Best Practice for Trend IP Based Products Information 

Sheet' (TP201331) and the Niagara 4 Hardening Guide, the advice described in the following sections must be 

followed. 

It is also recommended that you make use of the Niagara Security Service. For further details open Niagara Help and 

refer to the docSecurity guide. 

3.2 Disaster Recovery Planning 

When developing the disaster recovery plan ensure that it includes ALL data required to restore system operation, 

including: 

▪ Configuration files for platform(s) and station(s); 

▪ Database objects; 

▪ Licence and certificate files; 

▪ Station Backup; 

▪ Station Copies; 

See Backup the Configuration for details. 

3.3 Physical and Environmental Considerations 

The TONN8 should, where possible, be secured against unauthorised physical access. 

3.4 Security Updates and Service Packs 

Ensure the PC running TONN8 and any client devices have the latest operating system updates installed, and the latest 

version of TONN8 is being used. 

Trend software is tested against the latest service packs and updates applicable at the time of release. For significant 

operating system and Java updates / service packs, please check the Trend PNet web site (https://partners. 

trendcontrols.com) for any compatibility issues. 

https://partners.trendcontrols.com/
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3.5 Virus Protection 

Ensure the PC running TONN8 and any client devices are running virus protection software, and the virus definitions 

are kept up-to-date. 

Some virus protection software may have an adverse impact on the performance of TONN8. In such cases request 

that the TONN8 directory be excluded from on-access scan. 

Further details can be found on the Trend Partners web site (https://partners. trendcontrols.com). 

3.6 Network Planning and Security 

It is recommended that the Ethernet network used by the BEMS system is separated from the normal office network 

using an air gap, or virtual private network. Physical access to the Ethernet network infrastructure must be restricted. 

You must also ensure that the installation complies with your company's IT policy. 

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider of security products is 

recommended for any TONN8 installation. Follow best practice for the products chosen as well as any corporate IT 

policy where the installation is made. Lock down the products to the particular port you've configured for TONN8 

HTTPS and HTTP. 

Always follow the guidelines in the 'General Security Best Practice for Trend IP Based Products Information Sheet' 

(TP201331). 

You must also take steps to ensure the security of any other networks connected to TONN8 (e.g. BACnet). 

3.7 Virtual Environments 

Follow best practice for the products chosen as well as any corporate IT policy where the installation is made. 

3.8 Securing Wireless Devices 

If a wireless network is being used it must be secured according to your company's IT policy. 

3.9 System Monitoring 

For any TONN8 installation, especially when connected to the internet, Trend recommends the use of an Intrusion 

Detection System (IDS) from a reputable provider of security products. Follow best practice for the products chosen 

as well as any corporate IT policy where the installation is made. 

TONN8 logs changes made to its own configuration and adjustments to the Trend control system. Many IDS and 

firewall products offer a complete solution for recording all the traffic coming in and out of the TONN8 PC, providing 

users with the ability to record all activity at the lowest level. 

3.10 Securing Access to the Operating System 

Ensure the TONN8 is secured according to your company's IT policy. 

3.11 Access Control 

All TONN8 files should be protected against read and write access by people and software by unauthorised personnel. 

Trend recommends following best practice for securing system objects, such as files, and using access control 

appropriately. 

If  users are granted access to the filing system location of the TONN8 project then it is possible for them to 

inadvertently (or deliberately) open, delete or edit any of the configuration and data files of independently of their 

TONN8 workgroup settings. 

3.12 Securing TONN8 

The TONN8 software should be configured during installation and operation following best practice. Follow the 

installation procedure as described in this manual. For additional information open Niagara Help and refer to the 

docSecurity guide. 

3.12.1 Passphrase 

The passphrase, specified during the TONN8 installation process,protects sensitive data on any station that you create 

and will be required if the TONN8 station is to be copied to another TONN8, e.g. when restoring a backup in the event 

of hardware failure. 
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3.12.2 Default Admin User 

Initial system configuration is achieved using a default admin/engineering user account which is set up with a strong 

password when a Station is created. The password created for this account must be kept secure. 

3.12.3 Set up Other Users 

Once configuration is complete (using the default admin user) further user accounts must be added that grant different 

users specific access rights according their role. TONN8 enforces the use of strong passwords. For further details see 

the IQVISION Configuration Manual. 

3.13 General Data Protection Regulation (GDPR) 

The General Data Protection Regulation (EU) 2016/679 (GDPR) is a regulation in EU law on data protection and 

privacy for all individual citizens of the European Union (EU) and the European Economic Area (EEA). It also 

addresses the transfer of personal data outside the EU and EEA areas. The GDPR contains provisions and 

requirements related to the processing of personal data of individuals (data subjects) inside the EEA, and applies to 

any enterprise established in the EEA or (regardless of its location and the data subjects' citizenship) that is processing 

the personal information of data subjects inside the EEA. 

Under the terms of the GDPR personal data includes any information that may be used to identify an individual. This 

includes (but is not limited to): 

▪ user names, 

▪ passwords, 

▪ phone numbers, 

▪ email addresses, 

▪ work or residential addresses. 

Any such information entered into TONN8 is encrypted and stored on the PC where the TONN8 application is 

installed on a customer's premises. Neither Honeywell or Trend have any involvement with the storage and/or 

processing of personal data within TONN8. 

Responsibility for compliance with the requirements of the GDPR lies fully with the system integrator or system 

administrator and, as such, they must ensure that adequate technical and organisational systems are in place to: 

▪ obtain explicit consent from each data subject for personal data to be stored, used and/or processed, 

▪ allow individuals to have access to their personal data in order to verify accuracy, 

▪ allow individuals to withdraw their consent at any time and to have their personal data to be permanently 

erased, 

▪ maintain the security and integrity of data storage and access at all times, 

▪ report any breaches of data security (that may affect user privacy) to the relevant authority within 72 hours of 

the breach occurring. 
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4 ENGINEERING PROCEDURE 

TONN8 is configured using the IQVISION. For further details on how to install and licence IQVISION see the 

IQVISION Configuration Manual (TE201382). 

In general, it is recommended that IQVISION PC is connected to the TONN8 during its configuration: this is known 

as Online Engineering. However, it is possible to perform some configuration without being connected: this is known 

as Offline Engineering. 

Online Engineering Procedure 

Install TONN8 

License TONN8 

Connect to the IQVISION PC 

Open a Platform 

Run the Commissioning Wizard 

Set up a Station 

Open the Station 

Configure TCP/IP Settings 

Build the Trend IQ Site - see Build a Trend Site in the IQVISION Configuration Manual (TE201382). 

Connect to Third Party Systems - see Connect to Third Party Systems in the IQVISION Configuration 

Manual (TE201382). 

Link Values Between Trend and 3rd Party Systems 

Configure TONN8 to Receive Alarms - see Configure Alarm Handling in the IQVISION Configuration 

Manual (TE201382). 

Backup the Configuration 

If upgrading a TONN8 that has been configured using an earlier version of IQVISION - see Upgrade TONN8. 

Offline Engineering 

IQVISION can be used to create a station and configure it as required without being connected to TONN8. Once 

created, the station can be copied to TONN8 when running Commissioning Wizard or, if the Commissioning Wizard 

has already been run, by using the Station Copier. 
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4.1 Upgrading from an Earlier Version 

TONN8 can be upgraded to a newer version of Niagara to take advantage of new features and security improvements. 

Upgrading TONN8 Configured Using IQVISION v2.10 or Earlier 
IMPORTANT: TONN8s configured using IQVISION v2.30 (and above) have a completely different Trend driver to 

v2.10. Any stations cannot simply be copied to the new version. A special conversion process must be followed. 

Please refer to the IQVISION v2.10 to v2.30 Upgrade Manual (TE201431) for further details.  

Upgrading TONN8 Configured Using IQVISION v2.20 or Greater 
Any Stations configured using IQVISION v2.20, v2.30 and v2.40 use the same driver and can be used in a TONN8 

configured using IQVISION v2.50. 

IMPORTANT: All modules used by a TONN8 configured using IQVISION v2.50 are required to be signed by a valid, 

trusted certificate (or self-signed certificate). All modules shipped with IQVISION v2.50 are signed. However, some 

third party modules may not be signed and will require signing to enable their use in TONN8. For further information 

on signing a third party module open Niagara Help and refer to the DocEasyBinding guide or see the Easy Binding 

Manual (TE201458). 

To upgrade a TONN8: 

1. Make a platform connection to the TONN8 using the version of IQVISION that was used to configured it - 

see Opening an Existing Platform. 

2. Make a backup of the station - see Backup the Configuration Using the Station Copier. 

3. Connect to the TONN8's station using the version of IQVISION that was used to configured it - see Open 

the Station. 

4. If upgrading a TONN8 configured using IQVISION v2.40 the Point Database Manager must be removed 

from the station: 

▪ In the Nav tree open My Host > Station(TONN8) > Config > Services. 

▪ Right click the PDM service and select Delete to delete the PDM service. 

▪ In the Nav tree open the TONN8's IP address or host name > Platform and select Software Manager. 

The Software Manager dialogue box is displayed: 

▪ Select PointDatabaseManager-rt.jar,and PointDatabaseManager-ux.jar 

▪ Click Uninstall. 

▪ Click Save. 

5. In the Nav tree expand the TONN8 entry, right-click on Platform and select Commissioning Wizard. The 

first step of the commissioning wizard is displayed: 
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6. Follow the wizard. 

▪ On the Licences screen make sure the licence upgrade option is selected. 

▪ In the Software Installation screen, select Upgrade All Out of Date option and then manually select: 

iqNVisionLibrary-rt 

7. Click Next and continue to follow the wizard. 
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5 INSTALL TONN8 

TONN8 should be installed as described in the TONN8 Installation Instructions - Mounting (TG201414). 

To continue with the engineering procedure  proceed to License TONN8. 
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6 LICENSE TONN8 

Before TONN8 can be used it must be licensed. The licence determines both the number of points that TONN8 can 

monitor and the duration of a software update agreement.  

Obtain the TONN8 Licence and Certificate 

Install the TONN8 Licence 

Note: If the licenced functionality of TONN8 needs to be changed, (e.g. to increase the number of points or to install 

a new chargeable driver) it will be necessary to order and install a licence upgrade. For further details on the various 

upgrade options refer to the TONN8 Data Sheet (TA201413). 

6.1 Obtain the TONN8 Licence and Certificate 

The licence files are created at the time of purchase and are stored on a central server. To licence TONN8 these files 

must be downloaded and installed on TONN8. 

To obtain a licence and certificate: 

1. Email the following information to trendts@trendcontrols.com: 

▪ TONN8 serial number (printed on the label behind the front flap) 

▪ Host ID or 'Qnx' number (printed on the memory card case) 

▪ Trend sales order number 

▪ Your name 

▪ Company name 

▪ Email address that you would like the licence files sent to 

2. Once the request has been processed, the licence file(s) will be sent to the specified email address. 

6.2 Install the TONN8 Licence 

The TONN8 licence is emailed to you as a ZIP file containing a number of licence and certificate files which need to 

be installed on the PC that will be used to commission the TONN8, this can be done in two ways: 

Automatically 

Manually 

6.2.1 Automatic Licensing 

The easiest way to license TONN8 is to temporarily connect it to the internet and install the licence files from the 

server. 

To automatically install the licence files: 

1. Once the platform is open double click License Manager. The License Manager is displayed. 

2. Click Import. 

3. Select Import licences from the licensing server. 

4. Once the process is complete a dialogue box is displayed, click OK. 

5. Proceed to Connect to the IQVISION PC. 

6.2.2 Manual Licensing 

To manually license TONN8: 

1. Copy the ZIP file to the PC hard disk. 

2. Extract all the files from the ZIP to an empty folder. The folder should now contain two files: 

▪ Trend.license 

▪ Tridium.certificate 

You will need to access these files when running the Commissioning Wizard and they will be installed as 

part of the commissioning process - see Running the Commissioning Wizard. 

3. Proceed to Connect to the IQVISION PC. 
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7 CONNECT TO THE IQVISION PC 

To connect to the IQVISION PC: 

1. Ensure that the TONN8 is powered OFF. 

2. Connect the IQVISION PC to the TONN8 using the PRI (LAN1) Ethernet port only. 

The connection can be made via an Ethernet hub or switch: 

 

or directly using a standard Cat 5e patch cable: 

 

3. Record the PC's current IP settings, then (if necessary) change its IP settings to allow communication with 

the TONN8, for example: 

IP address Any value in the range 192.168.1.1 to 192.168.1.254, but not 192.168.1.140 

Subnet mask 255.255.255.0 

The factory-shipped IP settings for the TONN8 are: 

IP address 192.168.1.140 

Subnet mask 255.255.255.0 

4. Power up TONN8. 

5. Wait for 30 seconds for the BEAT indicator to commence a regular flash. 

6. Test the connection by 'pinging' the TONN8 from the PC. 
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7. Run IQVISION on the computer. The startup screen will be displayed:  

 

4. Proceed to Open a Platform. 
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8 OPEN A PLATFORM 

A platform connection to TONN8 is required for most host-level operations. This includes all configuration procedures 

such as setting up the network and TCP/IP settings. 

Open a New Platform 

Open an Existing Platform 

8.1 Open a New Platform 

If you are connecting to the TONN8 for the first time you will need to open a new platform using the procedure below. 

Otherwise, follow the procedure Opening an Existing Platform. 

To open a new platform: 

1. Connect to TONN8 and run IQVISION- see Connecting to the IQVISION PC. 

2. From the File menu select Open > Open Platform. The Connect dialogue box is displayed: 

 

3. Ensure that Type is set to Platform TLS Connection. 

4. Ensure that Host is set to IP and type the IP address of the TONN8 (i.e. 192.168.1.140) in the box provided. 

5. Check that Port is set to 5011. 

6. Click OK. The Identity Verification dialogue is displayed: 
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7. Click Accept. The Authentication dialogue is displayed: 

 

8. In the Username box enter the username for the TONN8 (default is tridium). 

9. In the Password box enter the password for the TONN8 (default is niagara). 

10. Click OK. A connection to the TONN8 will now be established and the Platform view is displayed. 

Note: The TONN8 appears in the Nav tree identified by its IP address. 

11. Proceed to Run the Commissioning Wizard. 

8.2 Open an Existing Platform 

Use the following procedure to connect to an existing TONN8 platform. If you have not previously opened a platform 

for the TONN8 follow the procedure Opening a New Platform instead. 

To open an existing platform: 

1. Connect to TONN8 and run IQVISION- see Connecting to the IQVISION PC. 

2. In the Nav tree, right-click the TONN8 (IP address) entry and select Open Platform. The Connect dialogue 

box is displayed: 

 

3. Click OK. The Authentication dialogue is displayed: 

 

4. In the Username box enter the username for the TONN8. 

5. In the Password box enter the password for the TONN8. 

6. Click OK. A connection to the TONN8 will now be established and the Platform view is displayed. 

7. Proceed to Run the Commissioning Wizard. 
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9 RUN THE COMMISSIONING WIZARD 

The first time TONN8 is powered up it is necessary to perform an initial set up using the Commissioning Wizard in 

IQVISION which steps through several specific configuration tasks to simplify the initial set up. Before starting you 

must obtain a licence for the TONN8 - see Licensing TONN8. 

The Commissioning Wizard gives the option to upload an existing station to the TONN8. Therefore, you may wish to 

create a station first - see Set up a Station. Alternatively, you can create a station and upload it after running the wizard. 

To run the commissioning wizard: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. In the Nav tree expand the TONN8 entry, right-click on Platform and select Commissioning Wizard. The 

first step of the commissioning wizard is displayed: 

 

On a first install most options are selected and cannot be deselected. For those options that can be changed it 

is recommended that you keep their default settings. The following procedure assumes that the default 

settings have been selected. 

Note: If the Commissioning Wizard is run again at some point most options can then be changed. 
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3. Click Next. If the TONN8 has automatically installed a licence it will be listed, and you can skip to step 8. 

Otherwise the wizard will show the following: 

 

4. Click Next. The wizard will show the following: 
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5. Click Add. The Select File dialogue box is displayed: 

 

6. Navigate to the location of the required licence file. Click on the file name (to highlight it). 

7. Click OK. The wizard will show the following: 
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8. Click Next. The wizard will show the following: 

 

9. Choose the required runtime profile options: 

UX Select to support Web client browser access, using HTML5, Java Script, and CSS technologies only 

(client does not need to run Java and download WbApplet from TONN8). Otherwise leave unselected. 

WB Select (in addition to UX) if the TONN8 must also support browser Web Workbench access from Java- 

enabled clients, using the WbApplet. Otherwise leave unselected. 

DOC Leave unselected. 

10. Click Next. The wizard will show the following: 
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11. If you do not have a pre-configured station available, or don't want to copy one to the TONN8 at this point, 

leave Station set to Don’t transfer a station and go to step 14. Otherwise, use the Station drop down box to 

select an existing station to copy to the TONN8. 

12. If required, you can enter a different name for the station in the New Name box. 

13. Set the START AFTER INSTALL and AUTO-START options as required. By default, these will both be 

selected. 

Option Description 

START AFTER 

INSTALL 

Select this option if you want to start the station as soon as it has copied 

(recommended). 

AUTO-START Select this option if you want the station to be started when the TONN8 is restarted 

(recommended). 

14. Click Next. After displaying a few 'Parsing' messages the wizard will show a list of software that will be 

installed: 

 

15. If required, you can review the list of software items that will be installed on the TONN8. Items that must be 

installed have a red or blue text descriptor. They are at the top of the list and cannot be deselected. Other 

items can be selected or deselected to suit specific applications. To reset the selection of modules to the 

original collection, click Reset. 
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16. Click Next. The wizard will show the following: 

 

17. Click Next. The TCP/IP configuration step is displayed: 

 

This step gives you the option to set up the IP settings for the two Ethernet ports. You can either do this now 

or after completing the wizard - see Configure TCP/IP Settings. 
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18. Click Next. The System Passphrase step is displayed: 

 

19. Type the default passphrase (niagara) in the Current Passphrase box. 

20. Type a new passphrase in the New Passphrase box.  

Note: The password must have a minimum of 10 characters and include at least one capital letter, one 

lowercase letter and one numeral (digit). 

21. Retype the new passphrase in the Confirm Passphrase box. 

IMPORTANT: Remember the passphrase. 

22. Click Next. The Platform Daemon Authentication step is displayed:  
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23. Type a suitable name for a platform admin user in the User Name box. 

24. Type a suitable password for the platform admin user in the Password box.  

Note: The password must have a minimum of 10 characters and include at least one capital letter, one 

lowercase letter and one numeral (digit). 

22. This must be at least10 characters in length and comprise a mix of upper and lower case letters and numbers. 

23. Retype the password in the Confirm Password box. 

Note: In the (optional) Comment field, you can enter an alphanumeric descriptor for this platform admin 

user. This text will be displayed in the 'Users table' and may be helpful if there is more than one platform 

user. 

26. Click Next. The wizard will show the following: 

 

27. If required, you can add further users at this point by clicking New User. Users can also be added, changed 

or removed later - see the IQVISION Configuration Manual (TE201382). 
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28. Click Next. A summary of the changes that will be implemented is displayed: 

 

29. Review the list of changes. You can use the Back button to go back to modify any settings. 

30. Click Finish to begin the commissioning process. This may take several minutes! Progress will be indicated 

by the wizard: 
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When the commissioning progress completes the wizard will look something like this: 

 

IMPORTANT: The TONN8 will go through several reboot cycles during the commissioning process. DO 

NOT TURN OFF POWER TO THE TONN8 DURING THIS TIME - DOING SO MAY CORRUPT THE 

CONFIGURATION. 

31. Observe the BEAT indicator on the front of the TONN8 unit - when this has a regular flash for at least 10 

seconds the unit has finish the setup process and is ready for use. 

32. Click Close. 

33. If you changed the primary Ethernet port settings on TONN8 remember that you may now need to: 

▪ change the IP settings on the configuration PC to restore communications between the PC and TONN8. 

▪ open a new platform in the IQVISION Nav tree - see Open a New Platform. 

34. If you copied an existing station to TONN8 using the Commissioning Wizard, you can now proceed to Open 

the Station. Otherwise, continue with Set up a Station. 
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10 SET UP A STATION 

The Station defines the network(s) that TONN8 will interface to. If you did not copy an existing station to the TONN8 

using the Commissioning Wizard, you will need to create a Station and copy it to the TONN8. 

10.1 Create a Station 

To create a station: 

1. Connect to the TONN8 and run IQVISION - see Connecting to the IQVISION PC. 

2. From the Tools menu select New Station. The New Station Wizard is displayed: 

 

3. In the Station Name box enter a suitable name for the station. 

4. Under Station Templates click on TONN8_STANDARD.ntpl to highlight it. 

5. Click Next. The wizard changes: 
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6. Click Set Password button. The Set Password dialogue box is displayed: 

 

7. Type a suitable password for the default 'admin' user in the Password box and retype the password in the 

Confirm box. 

Note: This password is for the default 'admin' user for the station. This user must be reserved for engineers. 

The password must have a minimum of 10 characters and include at least one capital letter, one lowercase 

letter and one numeral (digit). 

8. Click OK to return the New Station Wizard. 

9. Select the close the wizard option. 

10. Click Finish. The station will be created: 

 

11. Click OK. 

12. Proceed to Open the Station. 

10.2 Copy a Station to TONN8 

Once you have created a station it must be copied to the TONN8 using the following procedure. 

To copy a station: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. In the Nav tree right click the TONN8 platform and select Views > Station Copier. The Station Copier is 

displayed: 

 

3. In the Stations on this computer pane click the required station. 
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4. Click Copy. The Station Transfer Wizard is displayed: 

 

5. If required, rename the station in the Station name box, then click Next. The wizard changes: 

 

6. Select the required start-up options. 

Option Description 

START AFTER 

INSTALL 

Select this option if you want to start the station as soon as it has copied 

(recommended). 

AUTO-START Select this option if you want the station to be started when the TONN8 is restarted 

(recommended). 

7. Click Next. The wizard changes: 
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8. Click Finish. The transfer process will commence, and progress is shown in the Transferring station 

dialogue box: 

 

9. Wait until the message 'Transfer complete' appears. 

10. Click Close. The Open Application Director dialogue box is displayed: 

 

11. Click Yes. The Application Director is displayed: 

 

12. Wait for the station to start up - this make take up to a minute. Check that a 'Station Started' message is 

shown. In addition, Status at the top of the window will change from 'Starting' to 'Running'. 

13. Proceed to Open the Station. 
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11 OPEN THE STATION 

In order to configure a station (e.g. to add and set up drivers) it must be opened. 

To open the station: 

1. Make a platform connection to the TONN8 - see Open an Existing Platform. 

2. In the Nav tree right-click on the TONN8's IP address or host name and select Open Station. The Connect 

dialogue box is displayed: 

 

3. Click OK. The Identity Verification dialogue is displayed: 
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4. Click Accept. The Authentication dialogue box is displayed: 

 

5. Enter the password for the 'admin'user. 

6. Click OK. The Station Summary view will be displayed: 

 

7. Proceed to Configure TCP/IP Settings. 
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12 CONFIGURE TCP/IP SETTINGS 

The initial configuration of the TONN8 Ethernet ports can be performed as part of the commissioning wizard - see 

Running the Commissioning Wizard. If this step was skipped, or if the settings need to be changed at some point, 

follow the procedure below. 

Configure TCP/IP settings: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. Double-click on TCP/IP Configuration. The TCP/IP Configuration view is displayed:  

 

3. In the IPv4 Gateway box enter the IP address of the default router on the network. Default is 192.168.1.1. 

IMPORTANT: An IP address must be specified even if there is no router on the system. In this case, you 

must enter IP address that is valid for the network. 

4. Click Interface 1. The display expands to show the settings for the primary (PRI / LAN1) Ethernet port. 

 

5. In the IPv4 Address box enter the TONN8's IP address. 

6. In the IPv4 Subnet Mask box enter required subnet mask. 

7. If required, click Interface 2 to change the settings for the secondary (SEC / LAN2) Ethernet port. 

8. Click Save. If any changes require the TONN8 to be rebooted, the following prompt will be displayed:  
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9. Click Yes to reboot now. The following message is displayed: 

 

10. Observe the BEAT indicator on the front of the TONN8 unit - when this has a regular flash for at least 10 

seconds the unit has finish the setup process and is ready for use. 

11. Click OK. 

12. If you changed the primary Ethernet port settings on TONN8 remember that you may now need to: 

▪ change the IP settings on the configuration PC to restore communications between the PC and 

TONN8. 

▪ open a new platform in the IQVISION Nav tree - see Opening a New Platform. 

13. Proceed to Build the Trend IQ Site - see Build a Trend Site in the IQVISION Configuration Manual 

(TE201382). 

14. Proceed to Connect to Third Party Systems - see Connect to Third Party Systems in the IQVISION 

Configuration Manual (TE201382). 

15. Proceed to Link Values Between Trend and 3rd Party Systems. 
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13 LINK VALUES BETWEEN TREND AND 3RD PARTY SYSTEMS 

The values from the Trend system can be linked as required with values from the 3rd party systems e.g. to share the 

value of an outside air sensor. When linking values at least one of the values being linked must be writable. Before 

linking the values, they must be added to the database. 

Note: This is not required if the TONN8 is to only be used with IQVISION to read/write values from 3rd party system. 

To link the values: 

1. In the Nav tree open the folder containing the 3rd party value. 

2. Right-click on the required value and select Link Mark. 

3. In the Nav tree open the folder containing the Trend value. 

4. Right click the required value and select either Link From or Link To. 

Option Description 

Link From Value from the 3rd party point is put into the Trend value. Trend value must be writable. 

Link To Value from the Trend point is put into the 3rd party value 3rd party value must be writable. 

The Link dialogue box is displayed: 

 

5. In the [Target] area for the required point (indicated by the point's label) click the required write priority 

level (recommended level 10). This determines the priority given to the value when it is set. Values with a 

lower priority will take precedence, e.g. the user override in IQVISION is 8 and would therefore take 

precedence over the TONN8 value. 

6. Click OK. 

7. Repeat these steps for all points to be linked. 

8. Proceed to Configure TONN8 to receive alarms - see Configure Alarm Handling in the IQVISION 

Configuration Manual (TE201382). 

9. Proceed to Backup the Configuration 
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14 BACKUP AND RESTORE 

To ensure that the TONN8 configuration can be restored in the event of hardware or software failure it is recommended 

that the TONN8 configuration is backed up. Several options are available for backing up platform and station data in 

TONN8: 

Using Clone Backup 

Using the IQVISION Backup Service 

Using the Station Copier 

The following table provides an overview of each backup type: 

Backup 

Type 

Contents Size Tool(s) Notes Platforms 

Clone 

Backup 

Station bog, histories, alarms, 

copies of modules, JVM, OS 

image, platform configuration 

50+ 

MB 

Browser, USB 

port, debug port 

access 

Completely self- contained. May 

only be restored to the same 

model of controller. Does not 

require IQVISION. 

Niagara 4 

only 

Backup 

Service 

Station .bog file, histories, 

alarms, references to modules, 

JVM and OS version, and 

platform configuration 

<1 to 

50 

MB 

IQVISION Requires a clean dist 

(distribution) to downgrade 

Niagara 4 

and Niagara 

AX 

Station 

Copier 

Station .bog file, histories, and 

alarms 

<1 to 

50 

MB 

IQVISION Supports cross- model 

installation of station backup 

Niagara 4 

and Niagara 

AX 

Where possible the use of Clone Backup is recommended. The BackupService, which comes standard with 

IQVISION, backs up station files to a local supervisor or browser PC. A backup made by the BackupService includes 

only pointers to required core software modules. To restore from a backup made using IQVISION, not only do you 

need IQVISION, but also its software database with matching versions of all required core '.dist' files, OS '.dist' files, 

and software modules. Afterwards, use the Distribution File Installer to restore the backup. 

It is also important to ensure that the passphrase entered during the TONN8 installation, platform password and the 

password for the 'admin' user (specified when creating the TONN8 station) are available for use during any restore 

procedure. 

14.1 Backup the Configuration 

The configuration can be backed up in three ways: 

using the Clone Backup 

using the Station Copier 

using the Backup Service 

14.1.1 Backup the Configuration Using a Clone Backup 

The TONN8 allows you to back up the entire platform and station to a USB flash drive without needing to use 

IQVISION. The file created contains a complete image of the platform and station, including system modules and the 

QNX operating system. 

The clone backup and restore function is not supported if: 

▪ The TONN8 has been converted (downgraded) to run Niagara AX, or 

▪ The function has been disabled - see Enabling / Disabling USB Backup & Restore. 

You may create a clone backup while a station is running or stopped. When the TONN8 is powered on, the software 

continuously monitors the USB port. Putting a USB flash drive in the port triggers backup/restore mode. 

To create a clone backup: 

1. Ensure that the TONN8 is powered ON. 

2. Open the front flap of the TONN8. 

3. Insert a suitable USB flash drive into the USB port. The BACKUP indicator will turn ON. 

Note: If the indicator does not turn ON, check that the USB drive is correctly formatted, see Supported USB 

Devices, and that USB backup has been enabled, see Enabling/Disabling USB Backup & Restore. 

4. Press and hold the BACKUP button until the indicator begins flashing (100mS on and 100mS off). 
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5. Release the button. The system will begin creating the backup. While backing up, the LED flashes slowly 

(one second on, one second off). 

Note: If the USB drive has an indicator this will also flash while data is being written. 

6. Wait for the BACKUP indicator to turn off, indicating that the backup is complete. 

If the backup is unable to complete successfully, the indicator will continue with a repeated double flash 

every 3 seconds. In this case, simply unplug the USB drive, wait for the LED to turn off, then reinsert the 

drive and try the backup procedure again. If problems persist, check that there is enough space on the USB 

drive and that it is not write protected. 

7. When backup is complete (i.e. BACKUP indicator is off), remove the USB flash drive and store it in a safe 

place. 

The backup image includes the contents of the boot partition, /home/niagara, /opt/niagara, etc. The name of 

the resulting image file follows this convention: hostid (unique host ID of the TONN8), underscore (_) 

timestamp, For example: 

▪ Qnx-TITAN-XXXX-XXXX–XXXX–XXXX_20170912230355 

▪ Qnx-TITAN-XXXX-XXXX–XXXX–XXXX_20171015212346 

Supported USB Devices 

TONN8 supports USB flash drives (USB sticks) with a maximum capacity up to 128GB. The drive must be formatted 

with a FAT32 or FAT32X file system; NTFS is not supported. 

The use of USB bus powered external hard drives is not recommend as these often have higher power requirements 

and so may not function correctly and may result in permanent damage to the drive or to the TONN8.Plugging in an 

external hard drive may cause the TONN8 to become unresponsive, requiring a reboot. 

14.1.2 Backup the Configuration Using the Station Copier 

To create a station copy: 

1. Open the station - see Opening a Station. 

2. From the Tools menu, select Options. The Options dialogue box is displayed. 

3. Click the Station Copier Options:  

 

4. Set the following parameters to true state: 

Copy Remote Station Alarm Data 

Copy Remote Station History Data 

5. Click OK. 

6. In the Nav tree right-click on the TONN8 Station and select Save Station. 
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7. In the Nav tree double-click on the TONN8 Platform and double-click Station Copier. The Station Copier 

is displayed: 

 

8. In the right-hand pane select the TONN8 station folder and click the <Copy button. The Station Transfer 

Wizard is displayed:  

 

9. In the Station name box, type a new name for the backup (if required). 
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10. Click Next. The wizard changes: 

 

11. Select Copy every file in the station directory and its subdirectories. 

12. Click Next. The wizard changes: 

 



Backup and Restore 

TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 55 

13. Click Finish. The Transferring station dialogue box will be displayed showing progress: 

 

14. Wait for the text 'Transfer complete' to appear, then click Close. 
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14.1.3 Backup the Configuration Using the Backup Service 

Station backups (backups of the TONN8's configuration) are stored in a dist file on your PC. The back up includes 

the entire station folder plus the specific NRE config used by the TONN8 platform, including license(s), certificate(s), 

alarm data, history data, and jobs data. The dist also contains pointers to the appropriate NRE core, Java VM, modules, 

and OS. This allows for a complete replication from the one back up file. 

To create a backup .dist file: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. In the Nav tree open Station > Config > Services. 

3. Right click BackupService and select Views > AX Property Sheet. The property sheet is displayed: 

 

4. In the Exclude Directories box: 

▪ click file:^^history 

▪ click file:^^alarm 

5. Click Save. 

6. In the Nav tree double-click BackupService. The Backup Manager is displayed: 
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7. Click Backup. The File Chooser dialogue is displayed: 

 

8. If required rename the backup in the File name box. It will default to the format: backup_{station 

name}_{date}_{time}.dist 

9. Click Save. 

IMPORTANT: Backups created this way are stored as '.dist' files on the IQVISION PC. By default, these 

will be in C:/Users/xxxxxx/Niagara4.2/Trend/backups where xxxxxx is your user name. It is recommended 

that these files are copied to a different storage device/media and kept in a secure location. 

14.2 Restore the Configuration 

The configuration can be restored in three ways: 

using a Clone Backup 

using the Station Copier 

using the Dist file 

14.2.1 Restore the Configuration Using a Clone Backup 

Restoring from a USB backup returns the TONN8 to the state it was in when the system made the backup. You may 

restore to a TONN8 other than the one on which the backup was made, provided that the target is the same model/ 

variant with the same licensing. 

The restore procedure does not require IQVISION. However, a system shell connection to TONN8 will be needed. 

You will also need to know the system passphrase of the TONN8 that you are restoring to and the system passphrase 

used to create the backup. 

To restore a clone backup: 

1. Make a system shell connection to TONN8 - see Accessing System Shell Mode. 

2. Ensure that the TONN8 is powered OFF. 

3. Insert the USB flash drive (containing the backup) into the USB port. 

4. Press and hold down the BACKUP button and power up the TONN8. Keep the button pressed while the unit 

boots up. 

5. After approximately 30 seconds the BACKUP indicator will start flashing and the following message will 

appear in the terminal emulator window. 

******************************************************* 
Backup/Restore button press detected. Release button now to proceed.  

******************************************************* 
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6. Release the BACKUP button. The system will begin a 10-second countdown, 

which displays like this: 

Press any key to restore from USB backup. 
If no key pressed, factory recovery will begin in 10 seconds 
Recovery begins in 9 seconds 
Recovery begins in 8 seconds 

Recovery begins in...  

7. Press any key during the 10-second countdown to continue with the restore process. 

Note: If no key press is detected during this 10-second countdown, then the factory recovery process will 

begin as soon as the countdown finishes. If in doubt press a key – you will have the opportunity to abort the 

restore later in the process. 

When a key press is detected, the system enters the USB restore mode and the following banner displays: 

******************************************************* 
  Restore from a USB Backup 
******************************************************* 

Existing Niagara and platform installation will be completely removed!  
This includes 
  licenses  
  TCP/IP and WiFi configuration  
  platform credentials  
  TLS certificates  

If restoring a backup from another unit, you will need to install a new 
license.  

TCP/IP configuration and platform credentials will be set to values in 
the backup.  

Niagara daemon and station will be killed if they are currently running  

Enter the system passphrase for this system to proceed, or return to exit 

and reboot  

8. At the passphrase prompt, enter the current system passphrase for the TONN8 and press ENTER. One of the 

following happens: 

▪ If the entered passphrase does not match the system passphrase for this TONN8, after prompting a second time 

and no match, the BACKUP indicator flashes (200mS on, 200mS off) and you will be prompted to reset the 

system. 

▪ If the entered passphrase and the passphrase stored on the controller match, the system waits while the USB 

drive mounts (which can take a few minutes) and the following message appears: 

Waiting for USB drive to mount. Press any key to quit and reboot. 

Once the USB drive is detected, the following message and options display: 

USB drive detected  
This platform is Qnx-TITAN-XXXX-XXXX-XXXX-XXXX Please make your 
selection below  
1)  Abort Recovery/Restore mode andreboot  
2)  Show backups for other host IDs  

3)  Qnx-TITAN-XXXX-XXXX-XXXX-XXXX_20170706154109  

9. Type the number for a listed backup file name (for example: 3) or other option and press ENTER. 

Note: The backup file name is the name of the backup file stored on the USB flash drive: (hostid, underscore 

(_) timestamp). 

The system prompts you to enter the passphrase for the backup file. 
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10. At the prompt asking if the backup file’s passphrase is the same as the system passphrase for the controller, 

type Y (yes) or N (no). 

▪ If Yes, then the system passphrase entered in the earlier step is used to decode the backup. 

▪ If No, you must enter the passphrase for the backup file to decode the backup. 

11. If you entered N in the previous step, at the prompt enter the passphrase for the backup file and confirm it. 

The restore begins, the BACKUP indicator will flash. 

CAUTION: Once a restore begins,do not interrupt the process by removing the USB flash drive, 

disconnecting the power, or pressing the BACKUP button again. If you do not allow the restore to complete, 

the controller could be left in a non-functional state. 

When the restore successfully completes, the BACKUP indicator turns off and the system displays a message 

indicating that the restore is complete and that the controller requires a reset. 

12. Turn OFF the power to the TONN8. 

13. Remove the USB drive. 

14. Disconnect the USB cable used for the shell connection. 

15. Turn ON the power to the TONN8. 

14.2.2 Restore the Configuration Using the Station Copier 

To restore a station copy: 

1. Open the platform - see Opening an Existing Platform. 

2. Double click File Transfer Client. The File Transfer Client is displayed: 

 

3. In the left-hand pane browse to the folder where the files are saved. 

4. Click the required backup file and click >. The files are transferred.  

Once complete the following dialogue box is displayed: 

 

5. Click OK. 
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14.2.3 Restore the Configuration Using the Dist file 

To restore a backup .dist file: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. Double-click on Distribution File Installer. The Distribution File Installer is displayed: 

 

3. Click Choose Directory. The Change Directory dialogue box is displayed: 
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4. Navigate to User Home > backups. 

5. Click OK. A list of backup files is displayed. 

6. Click the required backup file. 

7. Click Install. The following dialogue box is displayed: 

 

8. Click Next. The dialogue box changes: 

 

9. If you want to change the TONN8 IP settings contained in the file, select the Update the remotehost’s TCP/ 
IP settings box, otherwise leave this unselected. 
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10. Click Finish. The Installing Distribution dialogue box will show a progress update: 

 

11. Click Close. 

Note: The Station connection will be terminated. You will need to reconnect - see Opening a Station. 
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Appendices 

The following appendices provide additional procedures and information that may occasionally be required when 

setting up TONN8. 

Upgrade TONN8 

Identify the Serial Ports 

Install Additional Drivers 

Reset to Factory Defaults 

Safe Shutdown Procedure 

System Shell Mode 

Configure TONN8 To Communicate with TOPS 

Enable/Disable USB Backup & Restore 

WiFi Interface Setup 

Synchronise the Time of IQ Controllers and TONN8 

Analytics 

E-Signature 

Honeywell Forge 
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A1 Identify the Serial Ports 

When configuring serial communications with 3rd party systems via RS-485 or RS-232 you will need to specify which 

port you are using based on its 'COM' designation. The TONN8 has two onboardRS-485 ports which are designated 

COM1 and COM2 as follows: 

RS-485-A       COM1 

RS-485-B       COM2 

Where additional serial ports are provided by installing RS-232(HON-NXEM-232) or RS-485(HON-NXEM-2X485) 

expansion modules, these have their ports numbered based on their proximity to the TONN8, as shown in the following 

examples: 
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A2 Install Additional Drivers 

If you have purchased additional 3rd party drivers that you did not install when the Commissioning Wizard was run, 

they must be installed before they can be used. If the driver is an additional purchase not included in your original 

license it will also necessary to update the TONN8's license see Upgrading a Licence. 

The new drivers will be supplied in an email. 

To install additional drivers: 

1. Close IQVISION. 

2. Save the driver files from the email to the C:\Program Files\TrendControlSystems\IQVISION\modules 

folder. 

3. Restart IQVISION. 

4. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

5. Double-click Software Manager. There will be a short delay while the list of software is compiled, after 

which the Software Manager is displayed: 

 

6. Click the driver that is to be installed to highlight it. 

7. Click Install. The selected driver and any dependencies will be selected. If necessary, click OK in any 

dialogue boxes that are displayed. 

8. Click Commit. The driver is installed. 

9. If the driver is an additional purchase not included in your original license it will also be necessary to update 

the TONN8 license – see Upgrading a TONN8 Licence. 

10. Add the additional driver to the TONN8 station– see Add the Required 3rd Party Drivers section in the 

IQVISION Configuration Manual (TE201382). 
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A3 Update a Licence 

If the licenced functionality of TONN8 needs to be changed, (e.g. to increase the number of points or to install a new 

chargeable driver) it will be necessary to order and install a licence upgrade. For further details on the various upgrade 

options refer to the TONN8 Data Sheet (TA201413). 

If you purchase a licence upgrade, e.g. for additional points or additional drivers you will be emailed the updated 

licence files as a ZIP file containing a number of licence and certificate files and it will be necessary to upgrade the 

TONN8 licence. If the TONN8 is connected to the internet this should happen automatically - see Automatic 

Licensing. If the TONN8 does not have internet access, it will need to be installed manually - see Manual Licensing. 

A3.1 Order an Upgrade 

To order a licence upgrade: 

1. Place an order with Trend in the usual way for the required upgrade package. You will need to provide the 

following information: 

▪ TONN8 serial number (printed on the label behind the front flap) 

▪ Host ID or 'Qnx' number (printed on the memory card case) 

▪ Email address that you would like the licence file sent to. 

Once your order has been processed, the licence file(s) will be uploaded to the global licensing server and 

sent to the specified email address. 

A3.2 Install a Licence Upgrade 

If TONN8 is connected to the internet, you can use the Workbench Licence Manager to get TONN8 to check for a 

new licence (Sync Online). If TONN8 is not connected to the internet you can use the Workbench Licence Manager 

to manually install the new files once they have been emailed to you. 

To access Workbench Licence Manager: 

1. Open the TONN8 station - see Opening a Station. 

2. On the Tools menu select Local License Database. The Workbench Licence Manager is displayed: 
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If TONN8 is connected to the internet: 

▪ Click Sync Online. The Sync All Licences? dialogue box is displayed: 

 

▪ Click Yes. TONN8 will access the global licencing server and the licence files will be installed 

automatically. A message is displayed indicating that the licence has been successfully updated: 

 

▪ Click OK. 

If TONN8 is NOT connected to the internet: 

▪ Unzip the licence file(s) supplied in the email to an empty folder on the PC. 

▪ In the Workbench Licence Manager click Import File. The Import License dialogue box is displayed: 

 

▪ Navigate to the required location and click the licence file to highlight it. 

▪ Click OK. A message is displayed indicating that the licence has been successfully updated. 

▪ Click OK. 
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A4 Reset to Factory Defaults 

To reset the TONN8 to the factory defaults it is necessary to install a 'clean distribution file'. Installing a clean 

distribution file will wipe the file system and install the appropriate version of the Niagara platform daemon,resetting 

the unit to a ‘near factory state’. Only the following settings are preserved: 

TCP/IP settings 

license files 

brand.properties 

All other data is removed from the file system. In addition, a clean dist restores the factory-default platform credentials 

and port (5011).Therefore, before installing a clean dist file, make sure to back up station files plus any other modules 

Backup & Restore. 

There are two methods of performing a reset to factory defaults: 

Reset to Factory Defaults Using IQVISION 

Reset to Factory Defaults Using the TONN8 Backup Button 

A4.1 Reset to Factory Defaults Using IQVISION 

To reset to factory defaults using IQVISION: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 
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2. Double click Distribution File Installer. After a short delay the following will be displayed: 

 

3. Click Cleaning. A list of clean distribution ('-clean.dist') files is displayed: 

 

4. Click the file that is not greyed out. 



Backup and Restore 

70 TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 

5. Click Install. If any applications are running the following dialogue box will be displayed, in which case 

click Finish to proceed: 

 

6. Wait while the reset process commences, and progress is displayed in the Installing Distribution dialogue 

box. When finished, the message 'Installation complete' will appear: 
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IMPORTANT: The TONN8 will go through several reboot cycles during this process. DO NOT TURN 

OFF POWER TO THE TONN8 DURING THIS TIME - DOING SO MAY CORRUPT THE 

CONFIGURATION. 

7. Observe the BEAT indicator on the front of the TONN8 - when this has a regular flash for at least 10 seconds 

the unit has finish the reset and reboot process and is ready for use. 

8. Click Close. 

A4.2 Reset to Factory Defaults Using the TONN8 Backup Button 

To reset to factory defaults using the TONN8 backup button: 

1. To use this procedure the USB backup feature must have been enabled - see Enabling/Disabling USB Backup 

& Restore. 

2. Perform a safe shutdown of the TONN8 - see Safe Shutdown Procedure. 

3. Power off the TONN8. 

4. Press and hold down the BACKUP button and power up the TONN8. Keep the button pressed while the unit 

boots up. After approximately 30 seconds the BACKUP indicator will start flashing. 

5. Release the BACKUP button. After a further 10 seconds then the factory reset process will begin. 

CAUTION: Once the reset process begins,do not interrupt the process by disconnecting the power, or 

pressing the BACKUP button again. If you do not allow the reset to complete, the controller could be left in 

a non- functional state. 
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A5 Safe Shutdown Procedure 

Before removing power to the TONN8 it is advisable to perform the following safe shutdown procedure in order to 

prevent any loss of data. 

To safely shutdown the TONN8: 

1. Open the front flap of the TONN8. 

2. Using a small flat-blade screwdriver (or similar) press in and hold the recessed SHT/DWN button. 

3. Observe the BACKUP indicator and wait until it begins a fast flash (100ms on, 100ms off). 

4. Once the indicator is flashing, release the SHT/DWN button. 

5. Observe the BACKUP indicator - it will stay fully lit, then begin a slow flash(1s on, 1s off) and finally turn 

off. 

6. Once the indicator is off, it is safe to remove power to the TONN8. 

Note: If the BACKUP indicator continues to flash twice every 3 seconds this indicates that the software was 

unable to put the system into a safe state. You will need to connect to TONN8 using IQVISION and determine 

the problem. 



Backup and Restore 

TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 73 

A6 System Shell Mode 

System shell mode enables basic engineering tasks to be performed on the TONN8 platform without the need for 

IQVISION. 

A6.1 Accessing System Shell Mode 

In order to use system shell mode a serial connection must be made between the TONN8 and a PC/laptop computer. 

The computer must also have a suitable terminal emulator program installed (e.g. PuTTY or HyperTerminal). 

To connect to TONN8 in system shell mode: 

1. Perform a safe shutdown of the TONN8 - see Safe Shutdown Procedure. 

2. Power off the TONN8. 

3. Open the front flap on the TONN8. 

4. Connect a suitable cable between the TONN8 DEBUG connector (Micro A USB) and a spare USB connector 

on the computer: 

 

5. Run the chosen terminal emulator program and configure it with the following comms settings: 

▪ baud rate: 115200 

▪ data bits: 8 

▪ parity: N 

▪ stop bits: 1 

Hint:If you are unsure which COM port to open Windows Device Manager, look under Ports, plug in the 

USB cable and note which port number appears. 

6. If you are restoring a clone backup see Restoring a Clone Backup, otherwise, for general information on 

using the shell mode - see Using System Shell Mode. 
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A6.2 Using System Shell Mode 

To use system shell mode: 

1. Make a system shell connection to TONN8 - see Accessing System Shell Mode. 

2. Power up the TONN8. The emulator will display a sequence of boot up messages. After approximately 30 

seconds a Login prompt will appear. 

3. Type in a user name for an admin user (e.g. the same as for logging into the Platform)and press the <enter> 

key. 

4. At the Password prompt type in the appropriate password and press the <enter> key. Once you have 

successfully logged in the following list of menu items will be displayed: 

TITAN System Shell 
----------------------------------------------------------------------- 

hostid: Qnx-TITAN-XXXX-XXXX-XXXX-XXXX  
serial number: XXXXXXXX build version: 4.X.XX.XX  
build date: built on 2016-08-29 21:49:55  
system time: Thu Jul 06 15:29:08 UTC 2017 niagara daemon port: 3011  
dm0:  inet 192.168.1.140 netmask0xffffff00 broadcast 192.168.1.255 
inet6 fe80::6264:5ff:fef1:e73%dm0 prefixlen 64 scopeid 0x2  
dm1: <disabled> 

----------------------------------------------------------------------- 
1.    Update System Time 
2.    Update Network Settings 
3.    Ping Host 
4.    Enable/Disable SSH/SFTP 
5.    Change Current User Password 
6.    Change System Passphrase 
7.    Enable Front Panel USB 
8.    Configure WIFI 
9.    Reboot 
L.    Logout 

Enter choice: 

5. Type the required option number (1 to 9, or L) and press the ENTER. 
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A7 Configure TONN8 To Communicate with TOPS 

By default, TONN8 uses Niagara4 (N4), whereas TOPS uses Niagara AX 3.8. This creates an issue in that AX cannot 

communicate correctly with N4, although N4 can communicate correctly with AX. 

In order to add TONN8 to TOPS (e.g. when replacing a TONN 2, 3 or 6 with a TONN8) the following two stage 

process must be followed. 

Downgrade TONN8 to AX 

Commission the TONN8 Using TES 

Note: If replacing a TONN 2, 3 or 6 with a TONN8 and you wish to restore a backup of the original TONN it is also 

necessary to downgrade the TONN8. 

A7.1 Downgrade TONN8 to AX 

To downgrade TONN8 to AX: 

1. Make a platform connection to the TONN8 - see Opening a Platform. 

2. Double click Distribution File Installer. After a short delay a list of distribution ('.dist') files is displayed: 

 



Backup and Restore 

76 TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 

3. Click Conversion. The list of files will update: 

 

4. Select the N4toAX-qnx-jace-titan-am335x-clean.dist file. 

5. Click Install. If any applications are running the following dialogue box will be displayed, in which case 

click Finish to proceed: 
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6. Wait while the conversion process commences, and progress is displayed in the Installing Distribution 

dialogue box. When finished, the message 'Installation complete' will appear: 

 

IMPORTANT: The TONN8 will go through several reboot cycles during this process. DO NOT TURN 

OFF POWER TO THE TONN8 DURING THIS TIME - DOING SO MAY CORRUPT THE 

CONFIGURATION. 

7. Observe the BEAT indicator on the front of the TONN8 - when this has a regular flash for at least 10 seconds 

the unit has finish the reset and reboot process and is ready for use. 

8. Click Close. 
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A7.2 Commission the TONN8 Using TES 

To commission the TONN8: 

1. Close IQVISION. 

2. Open the program folder for TES 1.82 (AX3.8.111.1). 

3. Click Install Platform Daemon. 

4. Once this has completed you can then launch the main program by clicking on TONN Engineering Suite. 

5. Connect to the TONN8 in the usual way. 

6. Right click on the Platform and select Commissioning Wizard. The wizard will be displayed: 

 

7. Select the options that you require for commissioning. 

8. Click Next. 

9. Select the licence. 

10. Follow the rest of the commissioning steps as per AX 3.8: 
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11. Select the station you require: 

 

12. You will see a list of modules that need to be installed: 

 

13. The core files will also need to be installed: 

 



Backup and Restore 

80 TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 

14. You need to create a new passphrase for the TONN8, this is different from existing TONN2, 3 & 6 as this is 

using the secure platform: 

 

Note: The default passphrase is 'Niagara'. 

15. Check the change log and click Finish: 
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The installation will update the TONN8 and then restart: 

 

Once finished you can now access the station. 

A7.3 Connect to TOPS 

When configuring TOPS, the default (and recommended) setting for the TONN8 is FOXS. It is possible to change 

back to FOX by using TES to modify the FOX connection. 

To switch from FOXS to FOX: 

1. Connect to the station in TES and then navigate to Station > Config > Drivers > NiagaraNetwork. 

2. Right click NiagaraNetwork and select Views > Property Sheet. 

3. Expand the FOX service item: 

 

4. Change FOX Enabled to true. 

5. Change FOXS Only to false. 

6. Click Save. 
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A8 Enable/Disable USB Backup & Restore 

The USB backup and restore function is disabled by default. If this function is required, it must be enabled. 

To enable/disable USB backup & restore: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. Double-click Platform Administration. 

3. Click Advanced Options. The Advanced Platform Options dialogue box is displayed: 

 

4. To enable, ensure USB Backup Enabled is selected; to disable, ensure USB Backup Enabled is deselected. 

5. Click OK. 



Backup and Restore 

TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 83 

A9 WiFi Interface Setup 

TONN8 variants that are equipped with a WiFi interface can be configured to operate in either of the following modes: 

▪ Client mode which enables TONN8 to attach as a client to an already established IEEE 802.11 access point 

and network, or 

▪ Access Point mode which enables TONN88 to be configured as an access point for its own WiFi network. 

By default, TONN8 is supplied with its WiFi interface unconfigured and disabled. It must be configured and enabled 

before use. 

Note: The WiFi mode switch on the TONN8 can be used to enable/disable WiFi operation and switch between the two 

operating modes once they have been configured. Moving the switch to either the ACC or OFF positions will not 

enable WiFi operation if the modes have not yet been configured. 

When enabling more than one LAN port (applies to LAN1, LAN2, WiFi) the IP address for each must be configured 

on different subnets, otherwise the ports will not function correctly. 

A9.1 Configuring WiFi Access Point (ACC) Mode 

This procedure describes how to configure the TONN8 WiFi interface to run in Access Point mode. This configuration 

can be used either as a network for WiFi enabled field bus devices,or to provide browser or Workbench access to local 

tools. 

To configure WiFi Access Point mode: 

1. Commission the TONN8 - see Run the Commissioning Wizard. 

2. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

3. Double-click WiFi Configuration. The WiFi Configuration view is displayed: 

 

4. Check that WiFi Enabled is set to false. 
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5. Check that WiFi Switch Position shows Off. If not, you must move the WiFi mode switch on the TONN8 

to the OFF (centre) position. 

6. Set Country of Operation as required by selecting the appropriate two-digit country code. 

IMPORTANT: Configuring the County of Operation is a permanent change to the unit that cannot be 

altered. 

7. Click the Access Point Mode tab. 

8. Change the Adapter IPv4 Address and/or Adapter IPv4 Netmask values if required. 

Default values are 192.168.11.1 and 255.255.255.0 respectively. These set the address that a client uses to 

make an IP connection to this TONN8 over WiFi when the TONN8 is functioning as an access point. 

Note: The IP address and subnet must not conflict with IP addresses used for wired Ethernet connections. 

9. In the DHCP ServerSettings pane, in the Client Range Low field, enter the lowest IP address for the range. 

Note: The adapter IP should be in the same subnet, but not in the range of addresses defined here. 

10. In the Max Number of Clients Allowed field, enter the maximum number of WiFi clients that can attach at 

a given time (default is 11, maximum is 16). 

Note: The WiFi interface supports a maximum of 3 user interface devices such as, a laptop, PC, or WiFi 

phone, at a given time. However, this limit is not enforced. 

11. In the Access Point Config area, click in the Ssid field and enter an appropriate name for this access point. 

This is the network name that client applications will connect to. The default name should always be changed 

to ensure security. Where multiple TONN8 units exist on the same site each unit must have a unique SSID. 

12. Set the Broadcast SSID box as required: 

▪ If checked (default), the TONN8 periodically broadcasts a WiFi signal so that devices can detect and 

connect to the network. Use this setting for connecting field bus devices. 

▪ If unchecked, the SSID is hidden and not discoverable. This requires a client to be manually configured 

with the correct SSID which matches the TONN8 Ssid field above. 

13. Enter a Passkey for the unit. 

This is a password that a client must provide in order to connect to this network. This should contain a mix 

of upper and lowercase letters and numbers and be at least 8 characters long. 

14. Click the Wpa Mode dropdown list and select the preferred wireless encryption mode: 

WPA WPA2 (default) This setting will accommodate most devices. 

WPA2 Use for newer devices only that support WPA2 protocol. 

WPA Use for older devices only that do not support WPA2. 

15. Click the Key Management Algorithms dropdown list and select an encryption algorithm appropriate for 

the devices connecting to this network: 

▪ WPA-PSK(default) 

▪ WPA-EAP 

▪ WPA-PSK WPA-EAP 

16. Click the Pairwise Cipher Suites dropdown list and select an encryption suite appropriate for the devices 

connecting to this network: 

▪ TKIP 

▪ CCMP 

▪ TKIP+CCMP (default) 



Backup and Restore 

TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 85 

17. In the Inactivity Timeout field, enter a value in minutes (default is 10), or enter 0 to disable this function. 

This sets a limit on the amount of time a client connection can be inactive. On reaching the timeout limit, the 

WiFi adapter will shut down completely and will require restarting - see Restarting the WiFi Interface (after 

an inactivity timeout). 

If the intended WiFi usage is for tool connectivity, then set this value to some small number of minutes. If 

the intended WiFi usage is for field bus integration, then set this value to ‘0’ to disable the Timeout 
functionality. 

Note: An access point represents a potential target for cyber-attack. Leaving the Access Point disabled by 

default is a recommended security best practice. 

18. To configure a Whitelist, check the Enable Whitelist checkbox and then click the Whitelist button. The 

Edit Whitelist dialogue box is displayed: 

 

Note:A whitelist is an inventory of up to 16 known MAC addresses that are permitted access to the WiFi 

access point, functioning as an added layer of protection for the WiFi network. 

Note: Leaving the Enable Whitelist checkbox unchecked (i.e. not using a whitelist) will allow access by any 

device. 

To add a new MAC address to the list: 

▪ Click+ and enter the address in the box. The format required is six HEX values separated by a colon 

(e.g. 08:00:69:E2:01:FE). 

▪ Click Save. 

To remove a MAC address from the list: 

▪ Click the address, then click the X button. 

19. To configure Mode and Channel properties, click the Config Channel button. The Configure Mode and 

Channel dialogue box is displayed: 

 

Note: You must have set the Country of Operation before changing the settings in this dialogue box. 

20. Click the Radio Mode dropdown list and select an appropriate IEEE-802.11 type for the devices connecting 

to the network. 

21. Click the Bandwidth dropdown list and select the preferred frequency band. The HT20 HT40 (default) 

option accommodates most devices. 

22. Click the Channel dropdown list and select the least congested channel number for your network. 

23. Click OK. 

24. Click Save. 

Note: The saved configuration changes take effect the next time WiFi is started. 
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25. At the top of the WiFi Configuration view, click on the WiFi Enabled dropdown list and select true. 

26. Move the WiFi mode switch on the TONN8 to the ACC (left) position. The WiFi interface will now start up 

in Access Point mode; this will take no more than 30 seconds. 

27. Check the Current WiFi State field - this should go from 'Stopped' to 'SAP Starting to SAP Running'. The 

TONN8 access point will now be available for connection. 

A9.2 Configuring WiFi Client (CLT) Mode 

This procedure describes how to configure the TONN8 WiFi interface to run in Client (CLT) mode. 

When configured for WiFi Client mode, the IP address is typically assigned by a WiFi router (using DHCP). You 

must ensure that the WiFi router is configured to assign IP addresses on a different subnet than that used by either the 

primary or secondary Ethernet ports, otherwise the ports will not function correctly. 

For TONN8 units deployed in the U.S. (and in countries that accept U.S. certification) an important consideration is 

determining whether the access point that the TONN8 will connect to is using Dynamic Frequency Selection (DFS). 

The TONN8 cannot connect to an access point that uses DFS channels in the 5 GHz range. The unsupported channels 

are: 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136 & 140. 

To configure WiFi Client mode: 

1. Make a platform connection to the TONN8 - see Opening an Existing Platform. 

2. Double-click WiFi Configuration. The WiFi Configuration view is displayed: 

 

3. Check that WiFi Enabled is set to false. 

4. Check that WiFi Switch Position shows Off. If not, you must move the WiFi mode switch on the TONN8 

to the OFF (centre) position. 

5. Set Country of Operation as required by selecting the appropriate two-digit country code. 

IMPORTANT: Configuring the County of Operation is a permanent change to the unit that cannot be 

altered. 

6. Click the Client Mode tab. 



Backup and Restore 

TONN8 Configuration Manual TE201415 Issue 6 09-Nov-2020 87 

7. The Wireless State pane displays read only values for the WiFi attach state, client adapter name, client MAC 

address and DHCP address as well as last access point. 

Note: If the Default Gateway Switching property is enabled (checked) when connecting to a third-party 

access point (such as Cisco), the gateway changes to whatever is provided by the access point’s configuration 
and this will conflict with your wired LAN settings. This situation does not occur when connecting to TONN8 

access point. 

8. Set WiFi Enabled to true. 

9. Move the WiFi mode switch on the TONN8 to the CLT (right) position. 

10. Check that WiFi Switch Position shows Client. 

11. Wait until Current WiFi State shows Sta Scanning - this may take up to 60 seconds to appear. 

12. In the Discovered Networks pane, click Discover to identify available networks. The Search for Access 

Points dialogue box is displayed: 

 

13. Select the required search options and click Discover. Any nearby networks will be listed: 

 

14. Click the SSID for the network that you want to connect to and click the Add button (or right-click the SSID 

and select Add). The Add a Wireless Network dialogue box will be displayed: 
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15. Set the Priority to a value between 1 and 9 to indicate which access point to try first. If all added networks 

have the same priority the client chooses the strongest signal. 

16. Enter the Network Key needed to connect to the access point. 

17. Click OK. 

18. In the Network Database pane, select the added network and click Connect. 

After a few seconds the Current WiFi State field should show 'Sta Running' indicating the WiFi interface 

is now configured and running in Client Mode. 

A9.2.1 Adding a New Wireless Network 

When the access point for a preferred network is not configured to broadcast its SSID, you can still add the network 

to the WiFi Client configuration, provided you know the SSID and Network Key (passkey) required to connect. 

To add a new wireless network: 

1. In the Network Database pane of the Client Mode tab,click New. The Create a New Wireless Network 

dialogue box is displayed: 

 

2. Configure the following properties for the access point: 

▪ Enter the SSID for the access point 

▪ Enter a Priority for connecting to the access 

▪ Modify the default security options as needed 

▪ Enter the Network Key (passkey) for the access point 

3. Click OK. The new wireless network is added to the Network Database table. 
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A9.2.2 Editing a Wireless Network 

The settings for a previously configured network, listed in the Network Database, can be edited. 

To edit a wireless network: 

1. In the Network Database pane of the Client Mode tab, click the SSID of the network to be edited. 

2. Click Edit. The Edit a Wireless Network dialogue box is displayed: 

 

Note: The Show Password checkbox is not activated until you change the current Network Key value. 

3. Edit the settings as required. 

4. Click OK. 

A9.2.3 Removing a Wireless Network 

If a network listed in the Network Database is no longer needed it can (and should) be removed. 

To remove a new wireless network: 

1. In the Network Database pane of the Client Mode tab, click the SSID of the network to be removed. 

2. Click Remove. A confirmation dialogue box is displayed. 

3. Click Yes to remove the network. 
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A9.3 Switching WiFi Modes 

If you need to switch between the access point (ACC) or client (CLT) WiFi modes, this can only be done with the 

WiFi mode switch on the TONN8. A platform connection with IQVISION is not necessary. However,a WiFi mode 

must have been configured before you can switch to that mode - see Configuring WiFi Access Point (ACC) Mode or 

.Configuring WiFi Client (CLT) Mode. 

When switching between modes it is important to allow time for the WiFi sub system to shutdown (typically less than 

30 seconds) before switching to another mode. 

To switch WiFi mode: 

1. On the TONN8, move the WiFi mode switch to the OFF (centre) position. If you have the WiFi 

Configuration view open in IQVISION, the WiFi Current State value will change to 'Stopping'. 

Wait for 30 seconds to allow the WiFi subsystem to shut down. If you have the WiFi Configuration view 

open in IQVISION, the WiFi Current State value will change to 'Stopped'. 

2. On the TONN8, move the WiFi mode switch to the required mode: 

▪ ACC (left) position for Access Point mode 

▪ CLT (right) position for Client mode 

A9.4 Restarting the WiFi Interface (after an inactivity timeout) 

If an inactivity timeout has occurred while operating in Access Point mode, the WiFi interface will automatically shut 

down after the specified timeout period. The TONN8 WiFi indicator will turn off and, in IQVISION's WiFi 

Configuration view, the Current WiFi Status will show as 'Inactivity Timeout'. 

Note: If inactivity timeout occurs regularly, or is undesirable, it may be necessary to increase the timeout period or 

to disable this feature. 

Restarting the WiFi interface after an inactivity timeout shutdown can only be done using the WiFi mode switch on 

the TONN8. You cannot restart the interface using IQVISION. 

To restart the WiFi interface: 

1. On the TONN8, move the WiFi mode switch to the OFF (centre) position. 

Note: If you have the WiFi Configuration view open in IQVISION, the WiFi Current State value will change 

from 'Inactivity Timeout' to 'Stopped'. 

2. Move the WiFi mode switch back to ACC (left) position to restart Access Point mode. 
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A10 Synchronise the Time of IQ Controllers and TONN8 

The time can be synchronized between IQ controllers and TONN8's connected on the network. 

To configure time synchronisation: 

1. In the Nav tree navigate to Station > Config > Services > PlatformServices. 

2. Double-click NtpPlatformServicesQnx. The Ntp Platform Service Editor Qnx view is displayed: 

 

3. Set the Use Local Clock as Backup parameter to false and all the other parameters to true. 

4. Click Save. You will be prompted to reboot the TONN8: 

 

5. Click No to reboot later. 

6. In the Nav tree navigate to Station > Config > Drivers. 
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7. Right-click on TrendIpNetwork and select Views > AX Property Sheet. The Property Sheet screen is 

displayed: 

 

8. Set the parameters (highlighted above) to true. 

9. Click Save. 

10. Reboot the TONN8. 
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A11 Analytics 

Analytics is a versatile software tool that enables energy usage data from the Trend Building Energy Management 

System (BEMS) to be collected and presented using a range of visualisation and reporting methods. 

Analytics is a licensable application within the TONN8 supervisor and/or TONN8 network node, giving full access 

to both Trend and third party system data. 25 analytic points are included with every IQVISION and TONN8 licence. 

Additional points require the purchase of an appropriate licence(s). For further details please refer to the IQV-NA-x, 

TONN-NA-x Analytics Data Sheet (TA201430). 

For further information on configuring and using Analytics, open Niagara Help and refer to the docAnalytics guide. 
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A12 E-Signature 

The E-Signature application facilitates compliance with the FDA’s 21 CFR Part 11. Points on the system can be 
protected, and when an adjustment is made details are recorded in an audit log with a date stamp, reason for change 

and details of the user who made the change. 

A licence is required to use E-Signature in your TONN8 station. The licence is based on the number of protected 

points required. For licensing options, please refer to the ESIG E-Signature Data Sheet (TA201432).  

For further information on configuring and using E-signiture, see E-Signiture Operation in the IQVISION 

Configuration Manual (TE201382). 
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A13 Honeywell Forge 

Honeywell Forge enables data from your system to be uploaded to Honeywell’s cloud, which provides powerful 
analytics of the data to provide identify maintenance issues sooner. 

To connect to Honeywell Forge it is necessary to: 

▪ Add the cloud connector driver to the station 

▪ Configure the station so that the necessary points are available to be sent to Honeywell Forge. 

▪ Configure the Honeywell Forge portal 

▪ Configure any other necessary services. 

Action Management is the first product that utilises Honeywell Forge. For more details refer to the Action 

Management documentation: 

▪ Action Management Data Sheet (TA201429) 

▪ Pulse for Connected Buildings App Installation Instructions (TG201443) 

▪ Action Management Manual (TE201428) 

▪ Action Management Manual (TE201445) 

These documents can be downloaded from the Trend e-library on the PNet support web site (https://partners. 

trendcontrols.com). 
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